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This book is intended for students on courses leading towards the Cambridge
Career Award, ICT Skills at Foundation level. The Award is designed for anyone
who wishes to develop basic competencies in a variety of ICT applications, and
to gain a broad, practical introduction to work-related ICT skills.

Chapter 1, General principles and procedures, is an introduction to the PC and
covers the essential skills and concepts. It is not tested, but before you go any
further you do need to understand the basics of Windows, be able to handle the
mouse and keyboard confidently, and have a sound grasp of the core file and
disk management techniques.

Chapters 2 to 4 cover the core modules. All students must study all of these.

� Chapter 2, Communication, introduces e-mail and the World Wide Web,
using Internet Explorer and Outlook Express.

� Chapter 3, Document production, explains the basics of word processing,
with examples from Word.

� Chapter 4, Data manipulation, introduces spreadsheets, using Excel.

Chapters 5 to 9 cover the optional modules. Students must take three of these.

� Chapter 5, Creating Charts, is written largely around the charting tools in
Excel, but also introduces Microsoft Graph.

� Chapter 6, Desktop publishing, looks at DTP page layout concepts and
skills, using Microsoft Publisher and Word.

� Chapter 7, Computer graphics, explorers techniques for creating and ma-
nipulating drawn objects, using Microsoft Draw.

� Chapter 8, Database operations, introduces key concepts and skills for
working with databases, using Access.

� Chapter 9, Web site design, shows how to create Web pages containing text,
images and hyperlinks, using a text editor and a browser.

���� �+����� ,�������
In each of Chapters 2 to 5 you will find one or two skills builder exercises. Each
has been designed to reinforce and test your understanding of the skills and
concepts covered in the preceding pages. Before tackling any skills builder, make
sure that you have fully understood the material leading up to it.

A full range of sample tests, and other resources for students is available from the
CIE Web site at www.cie.org.uk
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� How to use computer systems safely

� The basics of Windows

� How to use the mouse and the keyboard

� How to manage files and folders

� How to use floppy disks

� Key aspects of health and safety
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Computer systems come in all sizes, from
mainframes that can fill a large room down to
tiny hand-helds, but the most common type of
computer is a PC (Personal Computer) running
Microsoft Windows.

������
PC systems typically have these components:

� Monitor or VDU (Visual Display Unit). On
most desktop PCs this is similar to a TV,
though flat LCD screens are becoming more
common.  Newer monitors usually have
17 inch screens, capable of resolutions up to
1600 × 1200. (The resolution is the number
of pixels – dots of light – that make up the
screen.)

� System unit – the box containing the ‘works’.
This may act as a base for the monitor, or
stand beside it, as in the illustration, or on
the floor beneath.

On the front you should be able to see the
front panels of a floppy disk drive and a
CD-ROM drive, and two buttons – one is
the on/off button, the other the reset
button.
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At the back you will find a number of
sockets and connections, most with cables
plugged into them.

Inside, and best left to the experts, are the
power supply, the CD-ROM, floppy disk
and hard disk drives, and the main circuit
board (the motherboard ) containing the
main processor, the memory and other
chips; plus a sound card, graphics card,
modem and other circuit boards.

� Keyboard – though mainly for entering text
and numbers, the keys can also be used for
controlling software, as you will see.

� Mouse – used for controlling the cursor on
screen, allowing you to select items, start
programs, draw pictures, and more.

� There will also normally be speakers and a
printer, and possibly a scanner, attached.
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Windows is an operating system – and more. An
operating system handles the interaction between
the processor and the screen, memory, mouse,
disk drives, printer and other equipment. It is a
bridge between the hardware of the computer
and the applications – such as word processing or
spreadsheet programs. Whatever hardware you
are using, if it has a version of Windows, it can
run any application written for that or for earlier
versions of Windows. (This book assumes that
you are using Windows 95, 98, Me, NT or 2000
– the differences between them are very small,
and will be pointed out where it matters.)
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Routines vary, depending upon the version of
Windows and whether or not you are on a
network, but will usually be like this.

� Turn on the PC.

� If the monitor has its own switch, turn it on.

� Various messages and images will appear to
let you know that things are happening.

� If you are on a network, you will need to log
on – to enter your user name and password.

� After a few more minutes’ wait while the last
files are loaded and the system configured
for your use, the Desktop screen will appear.
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Desktops vary hugely, but you should see some
or all of these items.

"��������
These are icons – small images – with links to
programs, folders or Web sites. Clicking on the
icon will run the program, open the folder or
take you online. There will be some shortcuts
already on your Desktop, and you can easily add
your own.

$��	����
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This may be a flat colour, a pattern, a picture or
a Web page. It can be changed at any time
without affecting anything else.
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When you run an application, such as Word, it is
displayed in a window. This can be set to fill the
screen or to take a smaller area (see page 5).

���	���
This is normally along the bottom of the screen,
but can be moved elsewhere. It is the main
control centre for the Desktop, carrying the tools
to start and to switch between applications.

Start leads to the Start menu (see page 9).

The Quick Launch toolbar may be present. The
default tools lead to Internet Explorer, Outlook
Express and Media Player, and to the Show
Desktop utility, which shrinks all open applica-
tions out of the way so that you have a clear view
of the Desktop.

When you run an application, a button is added
to the Taskbar. Clicking on it will bring that
application to the top of your Desktop.

The Clock can also be displayed on the Taskbar.
You should find that it keeps good time – it even
adjusts itself for Daylight Saving Time!
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Applications can be started in several ways. Here
are the three easiest:

� Click the application’s desktop icon (if there
is one).

� Click on its name in the Start menu (see
page 9).

� Open a document that was created by or is
normally handled by that application. The
application will start automatically so that it
can open the document.
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When you have several applications running, the
current one – the one that you are working on –
will be on top. If its window is less than full-
screen, then the windows of other applications
may be partially visible underneath.

To bring a window to the top, and make it the
current one:

� If you can see any part of the window, click
on it.

� Otherwise, click on its button in the
Taskbar.
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Links to other applications can be added if
required.
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A window is an independent part of the screen.
It can be moved, resized, brought to the front or
overlaid by other windows. Programs are run in
windows, and documents are usually displayed in
windows within their programs. You can have
any number of programs running or documents
open at any one time, though you can only be
working actively in one window – the one on
top.

A window can be in three modes:

� Maximized – filling the whole screen.

� Restore – adjustable in size and position.

� Minimized – a program window is reduced
to a button on the Taskbar; a document
window is reduced to its Title bar only.
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The display mode can be changed using the
buttons  in the top right of the frame.

To maximize a window, click .

To minimize a window, click .

To restore a window to variable size, click .

When the window is maximized, the Restore
button replaces the Maximize button:

� In a maximized window .

� In a restored window .

The  Close button is always present.
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You can’t do much in Windows until you have
learned to use the mouse. It is used for locating
the cursor, selecting from menus, highlighting,
moving and changing the size of objects, and
much more.

Most mice are built around a ball. Moving the
mouse rolls the ball inside it. The ball turns the
sensor rollers and these move the cursor. To
control the mouse effectively you need a mouse
mat or a pad of paper – mice don’t move well on
hard desktops.

They don’t work well when they get dust and
fluff inside. If you find that the cursor starts to
move jerkily and becomes harder to control, take
out the mouse ball and clean it and the rollers
with a damp cloth. Dust inside the mouse can be
removed with tweezers. You do not need to turn
off the PC or disconnect the mouse before you
do this.

A newer type of optical mouse works by bounc-
ing a light off the surface of the mouse mat. A
sensor notices differences in the image and
changes mouse movement into cursor move-
ment. An optical mouse will work on any surface
and does not have problems with dust!

Note these points, for any type of mouse:

� If you are so close to the edge of the mat
that you cannot move the cursor any
further, pick up the mouse and put it back
in the middle.

� You can set up the mouse so that when the
mouse is moved faster, the cursor moves
further. Watch out for this when working
on other people’s machines.

(����� ���
�
�
Point – move the cursor with your fingers off the

buttons.

Click – click the left button. This action will
select a file, menu item or other object.

Right-click – click the right button over an
object on screen. This will open a menu of
commands that apply to that object.

Double-click – click the left button twice in
quick succession. This will run a program,
or open a document from its icon. You can
set the gap between clicks to suit yourself.

Drag – keep the left button down while moving
the mouse. Used for resizing, drawing and
similar jobs.

Drag and drop  – drag an object and release the
left button when it is in the right place.
Used for moving objects.
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Most Windows tasks can be handled by the
mouse alone, leaving the keyboard for data entry.
However, if you prefer typing to using the mouse,
you can do most jobs with the keys. The relevant
ones are covered here.
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These can be used in some applications to run
certain operations – but they vary greatly, and so
you have to learn the keystrokes. Two have the
same effects in any application:

[F1] starts the Help system.

[F4] press this, while holding down [Alt], to
close the application.
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The Arrow keys can often be used instead of the
mouse for moving the cursor. Above them are
more movement keys, which will let you jump
around in text. [Insert] and [Delete] are also
here.

[Esc] is used to cancel operations and escape
from trouble.
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[Tab] moves across the page in word processing,
or between objects in other displays – the
current, selected object will be highlighted.

[Caps Lock] can be turned on if you want to
type a lot of capitals. The Caps Lock light
shows if it is on.

[Num Lock] should be turned on to use the
number pad to type numbers, or off to use
the keys for movement.  The Num Lock
light shows if it is on.

[Shift] is used to obtain capitals and the symbols
on the top-row number keys.

[Control] is used with other keys to give key-
stroke alternatives to mouse commands.

 is the same as clicking .

[Alt] is used, like [Ctrl], with other keys.

[Backspace] deletes the character to the left of
the text cursor or any selected objects.

[Enter] is used at the end of a piece of text or to
start an operation.

[Delete] deletes the character to the right of the
text cursor or any selected objects.

[Insert] switches between Insert and Overtype
modes in most word processors.
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Menus give you easy access to sets of commands
and options.

There are three types of menus:

� All programs have a menu bar, containing all
of the program’s commands and options. To
open a menu, click on it, or press [Alt] and
the underlined letter – usually the initial –
e.g. press [Alt] and [F] for the File menu.

� For many objects on screen, e.g. icons,
blocks of text or drawn figures, you can
open a shortcut or context menu, containing
a set of commands and options that may be
used with that object. Right-click over an
object to do this.

� Windows has its own special Start menu (see
page 9).

All menus are used in the same way:

� To select an item from a menu, click on it
or type its underlined letter.

� Some items are toggles. Selecting them turns
an option on or off. � beside the name
shows that the option is on.

� You sometimes get a set of options, of which
only one can be selected at a time. � beside
the name indicates the chosen option.

�  after an item shows that another menu
leads from it. Click on or point to the item
to open its menu.

� ... after an item shows that a dialog box will
open to get more information from you.

� If an item is ‘greyed out’ – written in grey
with a white shadow – it is not available at
that time. You may need to set other op-
tions, or select different types of objects,
before the command can be used.
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Click  to open the
Windows menu system.

From here you can run any
application on your PC, open
documents, get Help, find
files, customise your system
and close down at the end of a
session.

There are eight main options
on the first level menu:

Programs is the main route to your applications.
All the programs on the PC should have an entry
here, either directly on the Programs menu or in
a submenu leading from it.

Favorites holds links to selected places on the
Internet.

Documents holds a list of recently used docu-
ment files. Selecting one from this list will run
the relevant application and open the file for you
to work on.

Settings is used to customise the Desktop and
other aspects of the system and to set up printers.

Find (Search in Windows Me) will find files and
folders on your computer, your network and the
Internet, and help you to find people on the
Internet.

Help is one way into the Windows Help system.

Run lets you run a named application. This is
mainly used to run the setup program to install
new software.

Shut down is the safe way to end a session on a
stand-alone PC. If you simply switch off, you
may lose work in documents that have not been
saved recently.

If you are on a network, you will also have a Log
Off option. Use this at the end of a session to
close down your part of the network and leave
the PC ready for someone else to use.
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In Windows Me and in Office 2000, menus are
‘smart’. When they first open, they display only
the core items and those that you use regularly.
The rest are hidden, but will be shown if you
wait a few moments or if you click on the
double-arrow bar at the bottom of the menu.

If you use a program, it will be added to the
menu and become part of the displayed set in
future. If you don’t use a program for several
days, it will be dropped from the menu. As smart
menus are normally much shorter, it makes
selection simpler and faster.

�������
��	���
�������4������

	
���
 ����	����
�#
������
���
������	
���
���"���	%

$#
�������
��������

��
�
������
��#��#

�
		��	
�����"���	'� ��
�

�
�%

����
������#

������
��



�.

��������
A toolbar is a set of buttons that give one-click
access to commands and options. Most applica-
tions have at least one toolbar, and many applica-
tions have several – each with its own set of
commands – Word, for example, has 16 toolbars.

If an application has only one toolbar, this will
usually be placed beneath the menu bar.  Where
there are several, you usually have more control
over where they are placed. In Microsoft Office
applications, such as Word, the toolbars can be
fitted into the frame on any edge of the window,
or left ‘floating’ – as free-standing panels that can
be placed anywhere.
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The position of toolbars can be adjusted at any
time. To move a toolbar, drag on its handle, or its
title bar, or any part which is not covered by a
button.

In most applications, toolbars can be turned on
or off through options on the View menu.

Using toolbar buttons is easy! In most cases, all
you do is click on them. Sometimes, the button
will have a little arrow to its right. Click the
arrow to open up a palette of colours or other
options and select from there, or click the button
to use the default option.
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These are used for setting options and collecting
information. They vary greatly, but look out for
these features.
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Some dialog boxes have several sets of options,
each on a separate panel. These are identified by
tabs at the top. Click on a tab to bring its panel
to the front.

����	� ��/��
These are used where there are several options in
a set, and you can use as many as you like at the
same time.

� in the box shows that the option has been
selected.

If the box is greyed out, the option is not avail-
able for the selected item.

0��
�� �����
�
These are used for either/or options. Only one of
the set can be selected – this is indicated by a
black blob in the middle of the button.

 ���1���
� �
���
If a slot has a down arrow button  on its right,
click the button to drop down a list.

Click on an item in the list to select.
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At the bottom of the dialog box you will see:

 – click when you have set the options,
selected the file or whatever, and want to
close the dialog box;

 – click to fix the options selected so far,
but keep the dialog box open;

 – click to abandon any selections you
may have made and close the dialog box.
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The window frame contains all the controls you
need for adjusting the display.

4����� ����
When a window is in Restore mode – i.e. smaller
than full-screen – you can drag on the edge to
make it larger or smaller (see page 13).

�
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This identifies the window and can be used to
move it (see page 13).
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This gives keyboard control over the window.
Press [Alt] and [Space bar] to open it. You only
need this if you cannot use the mouse.
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These change the display mode (see page 5).

�����
This is one of several ways to close a window and
the program that was running in it (see page 14).

(�
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Immediately below the Title bar in an applica-
tion window is a bar holding the names of its
menus. Click on a name to open its menu.

"������ ����
These appear on the right and at the bottom of
the frame if the contents are too big to fit within
the window. The sliders in the scroll bars show
you where your view is, relative to the overall
document. Move the slider to view a different
part of the document. Either:

� click an end arrow to move the display a
little in the direction of the arrow;

� click on the bar beside the slider to jump –
typically a screen width or height – in that
direction;

� drag the slider as required.
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When a window is in Restore mode – open but
not full-screen – it can be moved anywhere on
the screen.

To move the window, drag on its title bar.

� Click on the title bar and hold the left
button down.

� Drag the window to its new position.

� Release the mouse button.

0��
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When a window is in Restore mode, you can
change its size and shape by dragging the edges
of the frame to new positions.

Combined with the moving facility, this lets you
arrange your Desktop exactly the way you like it.

� Point to the edge or corner that you want to
pull in or out.

� When you get the  cursor, drag the
outline to size.

� Release the mouse button.

 �
�
�	
��#
�������

! ����
�����#
�����
����

" ���"��������	�����

 �
�
�	
��#
�������

?����������"����

�"
��������
�

! 3���������#
�
�"
��������
�

��
�)
$#
��
	�5
������
�	���������
��� #
���#

�����
���	�������
�"
'������#
����	���
��
�"�����������"���������%

�
�)
&#
���#
� ���� ��	��
��"����
�'�������
=�	��	#� ��	���"�
��������
����#�
$�$���
$

	
�����
�$��������%%��%��	�����
�����%�$#�	��	
��
�����#
��������	�����3���
���
	�������	
4�
2����
��#
	
������	�����	
����"	�����#

��������3��
�����������
����
�
	�
�%

" ���"��#
�������
����	�5




�#

����

���

����
When you exit from a program, you close its
window. And when you close a window, you
close the program that was running inside it.

If you haven’t saved your work, most programs
will point this out and give you a chance to save
the document before closing.

There are several different ways of closing. Here
are the simplest four:

� If the window is in Maximized or Restore
mode, click , the Close icon, at the top
right of the title bar.

� If the window has been Minimized onto the
Taskbar, right-click on its button to open its
context menu and use Close.

� Open the program’s File menu and select
Exit or Close.

� Hold down [Alt] and press [F4]. �
�
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My Computer is the tool that we will use for
managing files. Start it from its Desktop
icon (the icon image varies – this is mine).

The main part of the window shows the contents
of the current drive or folder. At first it shows the
drives and main folders on your computer.

� To see what is in a drive or folder, double-
click on its icon. A new window will open to
display its contents.

� When you have finished with a window,
click  to close it.

All the commands can be reached through the
Menu bar, but those that are used most often can
also be reached through toolbar buttons.

There are three toolbars for exploring your PC:

� The Address bar shows the current folder
and can be used to move around the system.

� The Status bar shows information about the
objects in the folder or any selected ones.

� The Standard toolbar contains buttons for
all the essential jobs:

� Back and Forward take you to folders
opened earlier.

� Up takes you up to the next level folder,
or from a folder to the drive.

� Cut deletes the selected file(s) but keeps a
copy in the Clipboard (see page 45).

� Copy copies the file(s) to the Clipboard.

� Paste copies the file from the Clipboard
into the current folder.

� Undo undoes the previous action, if it
can.

� Delete deletes selected items.

� Properties opens the Properties panel for
the selected item.

� Views leads to a drop-down list holding
the main options from the View menu.
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In Windows Me, Cut, Copy and Paste are
replaced by:

� Move To which moves the selected file to a
folder picked from a list at the next stage.

� Copy To copies the selected file to another
folder.

7/������� $��
You can open the Explorer Bar on the left of the
window to display the folder list. (It can also be
used for Search, Favorites and History which are
mainly used when exploring the Internet.) The
Folders list is useful.

� Open the View menu, point to Explorer Bar
and select Folders.

In the Folders list,  to the left shows that a
drive or folder contains a lower level of folders.

� Click  to bring the next level of folders
into view. The icon changes to .

� Click  when you want to hide the lower
level of folders again.

� Click on a folder name to select it and to list
its files and folders in the main part of the
display.
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Files and folders can be shown as Large Icons,
Small Icons, List, Details or Thumbnails.

Large Icons are easier to see, but you don’t get
many at a time unless you have a large window.

Small Icons and List both show a small icon and
the name. Small Icons lists them across the
screen, List aranges them in columns.

Details shows the name, size, type and last
modified date of each file.

The Thumbnails view is only available in
Windows Me. It shows – if one is available – a
miniature image or preview of each file.

The best way to look closely at your files is with
the Details view. Change to it now.

� Click the arrow by the View button  to
drop down the list, and select Details.

� Click  to open the drives and folders down
to a level where there are a reasonable
number of files.

� Click on the Name heading to sort the files
in ascending order of name. Click it again to
sort them in descending order.

� Click the Modified heading to sort the files
by date last modified. This display is useful
for tracking down files that you were work-
ing on at a certain date (but have forgotten
the names).
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Look at the contents of any folder in Details
view, and read what is in the Type column. You
will see that most document files have a linked
application – the one that will be run when the
file is opened.

Windows identifies a file’s type by its extension –
the three letters after the filename – and it knows
about most types. Sometimes you will meet a
new type of file, and you will have to tell Win-
dows which program to use.

To open a file:

� Double-click on the file, or right-click and
select Open or Open with…

� If Windows knows the type, it will run the
linked application and open the file. If not,
the Open With… dialog box will appear:

� Enter a Description – this will be shown in
the Type column in Details displays.

� Scroll through the list of programs and pick
the one to use with this file.

� If the program isn’t in the list, click Other
and browse through your folders for it.

� Tick the Always use this program box, if
relevant – sometimes you may want to use
different programs with the same file.

� Click OK.
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Windows automatically sets up a folder called
My Documents as a place for you to save your
files. This is unlikely to be enough for very long.
You will need more folders if you will be storing
more than 50 or so documents – it is hard to
find files in crowded folders.

Ideally, you should have a folder for each aspect
of your work on the PC, e.g. private and business
letters, reports, memos and notes, or a folder for
each subject studied, with subfolders for indi-
vidual projects.

How you organise your folders is your decision,
but aim for a simple structure.

Do not have too many levels of folders – it can
get confusing. Create your main folders at the C:
drive or in My Documents, and do not have more
than two levels of subfolders within these.

A new folder can be created at any time, and at
any point in the folder structure.

� Run My Computer and open the C: drive.

� You need to be in the drive or folder which
will contain the new folder. Work down
through the folders to reach your target.

� Open the File menu, point to New, then
select Folder.

� A new folder will appear, called New Folder.
The name will be highlighted, ready for
editing. Replace it with one that identifies
the folder’s purpose. You could call
it ‘ICT Skills’ and use it for the files
you will create on this course.
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Before you work through the next two pages, find
an empty floppy disk or one where the files are no
longer wanted.

� Put the disk in the floppy disk drive.

� Click the My Computer icon on the
Desktop.

The drives and main folders on your PC will be
listed. Setups vary, but look for these two:

3½ Floppy (A:) – the floppy disk drive;

(C:) – the main hard disk drive.

The A: and C: drives are both used to store files,
but there are two big differences between them:

� Floppy disks are removable – they can be
taken away or used in another PC – and so
can be used for backups or for transferring
files between machines. The disk in the C:
drive is fixed into place.

� The hard disk in the C: drive can hold much
more than a floppy disk.

Compare the C: drive and a floppy disk.

� Right-click on the C: drive to open its
context menu and select Properties.

� Make a note of the Capacity value, then
click OK to close the panel.

� Repeat � and � with the A: drive, and
compare the two.

� Go back to My Computer and click on the
C: drive to display the drive’s contents.

� You should see a number of folders and files.
Note the objects value in the bottom left of
the Status bar.

	 Repeat � and � for A:. What is on the
disk?
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Before you can use a floppy disk, it must be
formatted. This marks out magnetic tracks on
the disk surface, dividing the area into numbered
blocks to provide organised storage space.

Floppy disks are usually supplied pre-formatted,
so this routine may not be needed on new disks.
It is, however, useful for cleaning up old disks as
it can be faster to use Quick Format than to
delete a lot of files.

� Insert the disk into the drive.

� Run My Computer.

� Right-click on the A: drive and select
Format.

� Make sure that it is set for the right capacity.
PC disks are almost always High-Density
1.44Mb (3.5").

� Select Full for a new disk, or Quick (erase)
to tidy up an old disk.

� Type in a label if you like – though writing
on its paper label is more useful!

� Turn on Display summary.

	 Click Start. Formatting takes only a few
moments.


 Read the summary at the end, and if there
are ‘bad sectors’ on the disk, throw it away –
the disk is unreliable. Click Close to shut
the Summary panel.

� Click Close to exit from Format.

 
�	� ����
� Label disks so that you know what is on

them.

� Protect them from physical damage, heat,
damp and sources of magnetism, including
electric cables and electrical machinery.
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